# Contents

1. Copyright Notice................................................................................................................................. 3

2. Getting started........................................................................................................................................... 5
   2.1 Creating a first Mark Set.................................................................................................................. 5

3. The Dynamic Marks palette................................................................................................................. 6
   3.1 Adding a Standard Mark................................................................................................................ 7
   3.2 Adding objects as Mark................................................................................................................ 7

4. Dynamic Mark Properties...................................................................................................................... 8
   4.1 Position.................................................................................................................................. 8
   4.2 Color..................................................................................................................................... 10
   4.3 Specific Mark Properties....................................................................................................... 11
      4.3.1 Cut Mark Properties......................................................................................................... 11
      4.3.2 Bearer Bars Properties..................................................................................................... 12
      4.3.3 Gradation Strip Properties............................................................................................ 13
      4.3.4 Changing the Symbol................................................................................................. 14
      4.3.5 Text Mark properties...................................................................................................... 14

5. Mark Sets............................................................................................................................................... 24
   5.1 Load Mark Set.......................................................................................................................... 24
   5.2 Save Mark Set.......................................................................................................................... 25
   5.3 Manage Mark Sets.................................................................................................................... 25
   5.4 Dynamic Marks Preferences.................................................................................................... 26
   5.5 Esko Mark Sets......................................................................................................................... 27

6. Tips and tricks....................................................................................................................................... 29
1. Copyright Notice

© Copyright 2012 Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2012. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.
The software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.
Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.
All other product names are trademarks or registered trademarks of their respective owners.
Correspondence regarding this publication should be forwarded to:
Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. Getting started

Using the Dynamic Marks plugin, you can create sets of marks, add them in a document, and have full control over these marks.

2.1 Creating a first Mark Set

1. Open a file in Illustrator. Create some objects you want to use as marks.
2. Go to Window > Esko > Dynamic Marks > Dynamic Marks to open the Dynamic Marks panel.
3. Click Create a Mark Set to start a new Mark Set.
   
   **Note:** This step is optional. If no Mark Set is present, you can also immediately start adding marks (see step 4), a new Mark Set will be created automatically.
4. You can add marks in two ways:
   - Select the objects you want to use as mark one by one, and click the Add Selected Art as Mark button.
   - Click the Add Standard Mark button to add a standard mark to the set.
5. From the fly-out menu, select Save mark set
   
   **Note:**
   You can only save a Mark set if the Illustrator file is saved. If not, you will be prompted to do so before saving the Mark Set.
In the Dynamic Marks palette, you can manage the marks in a set.

The palette will show the name of the latest loaded or saved mark set, and all the marks in the set. The icon in front of the mark name will show the type of mark: a standard mark, text, an object, ...

In the palette, you can

- change the name of a Mark by double-clicking it
- select and zoom in on a Mark, by clicking the button or from the fly-out menu
- add the selected artwork as a Mark, by clicking the button or from the fly-out menu. See Adding objects as Mark
- add a Standard Mark, by clicking the button or from the fly-out menu. See Adding a Standard Mark
- remove the selected Mark, by clicking the button or from the fly-out menu.

**Note:**

Removing a Mark will remove the entry in the Mark Set as well as the actual object.

- expand a mark, by selecting the function in the fly-out menu. Expanding a mark replaces the Dynamic Mark by a normal object.
Note: Same as in Adobe Illustrator's Layer palette, there are two different types of selecting in the Dynamic Marks palette:

- If you click the name, the Mark is selected in a blue bar, but the actual art is not selected in Adobe Illustrator. This selection is used for Dynamic Mark palette operations (zoom, trash, expand, remove).
- If you click at the right side of the row (or if you select the art using the Illustrator select tools), the Mark is showing a colored rectangle, indicating that the actual art is selected in Adobe Illustrator. This selection is used for the Marks Properties.

3.1 Adding a Standard Mark

You can add one of the predefined Standard Marks to your Mark set:

1. Click the Add Standard Mark button or select Add Standard Mark from the fly-out menu.
2. Select the Standard Mark you want to add.
3. Click Add.

The Standard Mark will be added to the Mark Set, and in the current document. You can change its properties in the Dynamic Marks Properties palette. See Dynamic Mark Properties.

The Standard Marks currently available are:
- Cut Mark
- Bearer Bars
- Gradation Strip

For more information on the properties for the Standard Marks, see Specific Mark Properties

3.2 Adding objects as Mark

You can add existing objects as a Mark to your set.

1. Select the object you want to use as a mark.
2. Click the Add Selected Art as Mark button or select Add Selected Art as Mark from the fly-out menu.

The new Mark will appear in the Dynamic Marks palette. You can change its properties in the Dynamic Marks Properties palette. See Dynamic Mark Properties.

Note: If you select multiple objects, these objects will be grouped and added as one single mark in your set.

Note: You can not create a Mark from any linked image.
4. Dynamic Mark Properties

You can open the Dynamic Mark Properties by choosing Window > Esko > Dynamic Marks > Dynamic Mark Properties

4.1 Position

The position of a Mark is based on 3 settings:

**Attach to**

The position of the Mark can be based on

- the Trim Box
- the Media Box
- another Dynamic Mark
- a PowerLayout Repetition, such as "PowerLayout Grid 1"
- Named Art

Named Art is any art in your Illustrator document, that you gave a name in the Layers palette: browse to the object you want to name in the Layers palette, double click the default name (eg. <path>) and enter a name.

When selecting Named Art..., you get a separate dialog, in which you can either type the name of the Named Art you want to use, or select it from the dropdown at the right. Once Named Art has been used, it remains available in the **Attach To** dropdown.

Named Art is only possible on objects, not on groups. Named Art can't be hidden or locked.

**Note:** Standard Marks will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Standard Mark is attached to the Trim Box.

A PowerLayout Standalone grid is a Step and Repeat of a single file or object(s), generated by the PowerLayout Standalone plug-in. If such a grid is available in the document, you can select its name in the dropdown. For more information, see the PowerLayout Standalone documentation.
**Positioning**

The way the Mark is attached, can be chosen by clicking and dragging the blue square (representing the Mark) to the desired position on the grey square (representing the Attach To reference). Each square has 9 reference points (top left center and right, middle left center and right, and bottom left center and right), so you have 81 different ways of positioning the mark.

This setting is not available for Bearer Bars and for Cut Marks.

In the example underneath, the top center of the (bounding box of the) mark will be placed on the left bottom corner of the (bounding box of the) reference defined in the Attach to field.

**Note:** If you create a Mark from an existing object, the Positioning settings (the blue rectangle) will be automatically set, using the smallest offset possible while keeping the object at the same location.

**Offset**

In the offset fields, you can move the mark based on the defined position. The direction of the offset (up, down, left or right) depends on the positioning, and is shown by the arrows.

**Note:** You can also manually move Marks. In that case, the offset will automatically adjust to the new location. The other settings (Attach To and Positioning) will NOT change.

**Repeat**

For custom marks, you can use the Repeat buttons, to choose if the mark should be repeated or not.

From left to right:

- No repeat
- Repeat on all 4 sides. The positions of the marks are rotated 90° around the center of the Attach To object. Examples:
4.2 Color

The color of a mark can be one of these settings:

**Registration**

The mark will be colored with 100% of every ink used in the document. If you change the tint to e.g. 42%, the mark will get 42% of every ink used in the document.

Changing the inks in the document can change the color of the mark. Technical inks are not used in the mark.

**Darkest**

The mark will be colored with 100% of the darkest ink used in the document. You can't change the percentage for "Darkest" ink, it will always be 100%.

Changing the inks in the document can change the color of the mark. Technical inks are not used in the mark.

**Dynamic**

If color is set to "Dynamic", the current color is stored, but based on the ink positions in the Ink Manager, and not the actual inks.

For example, if the first ink is Cyan, a 100% cyan mark is stored as "100% of the first ink". If the first ink is different (by changing the ink order, or by placing the mark on a different file), the mark will become 100% of the first ink.

Technical inks are not used in the mark. In the example above, if the first ink is a Technical ink, the mark will be empty.
Note: If the ink list in the document changes after adding the marks, you must click **Update Ink List** in the **Ink Manager** for the marks to adjust to the updated ink list.

**Static**

If color is set to "Static", the current color is stored, based on the actual inks. The color of the mark will not change if the order of the ink list is changed.

**Note:**

When placed on an existing document, "Static" marks are the only marks that affect the ink list: the inks used in the mark will be added if necessary.

**Defaults**

Every Dynamic Mark has a default color attribute:

<table>
<thead>
<tr>
<th>Mark Type</th>
<th>Available Color Options</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom mark (plain object)</td>
<td>all*</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Cut Mark</td>
<td>all</td>
<td>Darkest</td>
</tr>
<tr>
<td>Text</td>
<td>all</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Image Mark</td>
<td>Static, Dynamic**</td>
<td>Static</td>
</tr>
<tr>
<td>Dynamic Objects (Barcode, Panel, Table)</td>
<td>all</td>
<td>Static</td>
</tr>
<tr>
<td>Bearer Bar</td>
<td>all</td>
<td>Registration</td>
</tr>
<tr>
<td>Gradation Strip</td>
<td>No Color Options</td>
<td>not applicable</td>
</tr>
</tbody>
</table>

(*): A Custom mark created from a mesh or gradient object will always have color attribute "Static". This can’t be changed.

(**): An Image Mark will always be static, except for monochromatic images, which could be dynamic as well.

**Note:** A Gradation Strip doesn’t allow setting Color options. A Gradation Strip always uses every ink, except for technical inks.

### 4.3 Specific Mark Properties

Standard Marks have, beside Position and Color, some specific properties.

Also Text Marks have specific properties, allowing to create dynamic Text Marks.

#### 4.3.1 Cut Mark Properties

Cut Marks are created from a symbol named "CutMark", and are by default 0,1mm wide and 10mm long.
**Position**: Cut Marks will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Cut Mark is attached to the Trim Box.

**Color**: Cut Marks are by default in "Darkest" color.

**Offset**: allows to define the offset for the Cut Marks. A positive offset will move the Cut Marks to the outside.

**Symbol**: allows to change the symbol used for the Cut Mark. See *Changing the Symbol*.

### 4.3.2 Bearer Bars Properties

Adding a Bearer Bars mark will create two bars, one on each side, left and right (default) or top and bottom. The bars will automatically take the size (vertical or horizontal) of the “Attach” selection.
Position: Bearer Bars will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Bearer Bars are attached to the Trim Box.

Color: Bearer Bars are by default in Registration color.

Width: The width of the Bearer Bar.

Extend: allows to extend the Bearer Bar on both size. Entering e.g. +5mm will extend the Bearer Bar by 5 mm on both ends.

Offset defines the distance between the Attach to object and the Bearer Bars.

Orientation: vertical or horizontal.

4.3.3 Gradation Strip Properties

Gradation Strips are created from a symbol named “GradationStrip”, and are by default 3 rectangles of 5 x 5mm, horizontally, colored 40%, 80% and 100%, one strip per ink.

Position: Gradation Strips will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Gradation Strip is attached to the Trim Box.

If you change the Positioning setting (the blue rectangle), the gradation strip will rotate automatically based on the position of the blue rectangle.

Width: The width can be set to “One Strip per Ink” or to "Repeat to Fit".

Symbol: allows to change the symbol used for the Gradation Strip Mark. See Changing the Symbol,

You can use any type of art in the symbol, but only paths and compound paths will be colored. If you will use any text in your Gradation Strip symbol, it will be automatically colored with darkest ink.

If you change the default Gradation Strip symbol, the default position will be based on the size of the symbol. If the width of the symbol is bigger than its height, the Gradation Strip will be created horizontally by default. If the height is bigger, the Gradation Strip will be created vertically by default.
Flip: when set to "Normal", the gradation is built from left to right, when set to "Reverted", the gradation strip is built from right to left.

4.3.4 Changing the Symbol

You can change the Symbol used for a Standard Mark in the Dynamic Mark Properties, by clicking the Set Symbol button, and selecting the desired Symbol from the list.

To change or add Symbols,

1. In the Dynamic Marks palette, select Open Symbol Library from the fly-out menu
   The file DynamicMarks.ai will be opened
2. Use the Illustrator tools to add, edit, remove, duplicate, ... the symbols defined in the file.
3. Save and close the DynamicMarks.ai file

The new and modified symbols will now be available when clicking Set Symbol in the Dynamic Mark Properties.

4.3.5 Text Mark properties

A Text Mark is a Custom Mark created from a text object. Text Marks can consist of static and dynamic text.

1. Create a text object, using the font and text settings you want to use, and add it as a Custom Mark.
   For more info on adding objects as Mark, see Adding objects as Mark
2. Open the Dynamic Mark Properties palette, by choosing Window > Esko > Dynamic Marks > Dynamic Mark Properties

The existing text is static, which means it won’t change when you use the Mark into another document, or if the document changes.

You can make all or part of the text dynamic, to have it change with every document you use your mark into.
Note: If you want to have some static text, just leave that part of the text as it is (or type in new text) in the Text area.

3. To get dynamic text, you need to insert dynamic fields.

   Place your cursor where you want the field to be, or select the text to replace with a field, and click the Insert / Modify ... button.

4. In the Insert Field dialog that opens, choose the fields to insert:
   a) choose a field Category, for example Barcodes, Date & Time...
   b) in that Category, choose the Field you want to use (see Categories and Types for a list of available categories and fields),
   c) if applicable, choose the Format to use for your chosen Field (see Formatting Dynamic Fields for details),
Note: The Preview line shows how the field will be resolved in the current document.

d) when you are satisfied with how your field will look like, click OK.

The dynamic parts of a text object will appear between square brackets.

Categories and Types

**Barcodes**
- Number of Barcodes
- Barcode Type
- Barcode Code
- Bar Width Reduction
- Barcode Magnification
- Barcode Device Compensation
- Barcode Narrow Bar

**Date & Time**
- Date
- Time
- Date and Time
Document

- File Name
- Fonts
- Layer Names
- CMYK Profile
- RGB Profile
- Color Mode
- Trim Box
- Media Box
- Art Box

File Info (XMP)

- Description
- Author
- Document Title
- Author Title

Inks

- Number of Inks
- Number of Technical Inks
- Ink Names
- Technical Ink Names
- Short Ink Names
- Ink Types
- Ink Dotshapes
- Ink Angles
- Ink Rulings

Job (Automation Engine)

Note:
The fields in the Job (Automation Engine) category take the Automation Engine job folder information instead of the document information.

For example, the Ink Names field in this category will show the ink names defined in the job parameters, not the document's ink names.

Important: All Job related information requires an active connection with an Automation Engine server.

- Job Name
- Order ID
- Sub Order ID
- Description
- Due Date
- Project ID
- Last Actor
- Job URL
Dynamic Marks

- Category
- Custom Field 1
- Custom Field 2
- Custom Field 3
- Custom Field 4
- Custom Field 5
- Custom Field 6
- Customer ID
- Customer Name
- Customer Description
- Customer Contact Name 1
- Customer Contact Name 2
- Customer Contact Name 3
- Customer Contact Email 1
- Customer Contact Email 2
- Customer Contact Email 3
- Job Parameters
- Number of Barcodes
- Barcode Type
- Barcode Code
- Bar Width Reduction
- Barcode Magnification
- Barcode Device Compensation
- Barcode Narrow Bar
- Number of Inks
- Number of Technical Inks
- Ink Names
- Technical Ink Names
- Short Ink Names
- Ink Types
- Ink Dotshapes
- Ink Angles
- Ink Rulings

Links
- Placed Files
- XML Content Files
- Structural Design File

Product (Automation Engine)

**Important:** All Product related information requires an active connection with an Automation Engine server.

- Product Name
- Product ID
- Customer Name
- Customer Product Reference
- Product Description
• Product Part Name
• Product Part Status
• Custom Field 1
• Custom Field 2
• Custom Field 3
• Product Part Custom Field 1
• Product Part Custom Field 2
• Product Part Custom Field 3

System
• Illustrator Version
• Creative Suite Version
• OS Type
• OS Version
• Short User Name
• Full User Name

Formatting Dynamic Fields
You can format certain fields so they look a certain way (for example, have the date in European or American format).

You can use predefined formats or create custom formats. You can also choose to use a different format for each field, or the same format for all fields.

Using an Existing Format
• You can choose an existing format to apply to your field in the Format list.
  
  For example, use [name][ext] to display the file name and extension when using the File Name field.
Defining a Custom Format

To define your own field format:

1. Choose Custom in the format list.
2. Define your format in the box below (using the predefined formats and the information under ? for help).
Note:

- The items in square brackets, like [major], are dynamic, the rest of the text is static.
- Use the Enter key to get a new line.

3. Check how your format resolves for the current file in the Preview line.
4. Click OK when you are satisfied.

Repeating the Format for All Items

If the field you want to use can have several values (e.g. Fonts, Ink Names, Placed Files...), you can put them all in one dynamic object.

You can also set the same format for all those values at once.

After choosing an existing format or defining a custom one:

1. Select Repeat format for all items.
2. Choose the Separator you want to use between the values (Comma, Space...).
Note: You can also specify your own separator by typing it directly in the Separator list.

Separator: &

Preview: HelveticaNeue-Bold & HelveticaNeue-Roman

3. When you are satisfied with what you see in the Preview, click OK.

Reflow text

If you create a custom mark based on text in a text frame, resizing using standard transform tools will resize the text "as is" instead of reflowing the text inside the resized text box.
If the Reflow Text option is enabled, resizing using standard transform tools will resize the text box, and the text will reflow inside the resized text box.
5. Mark Sets

When no mark set is loaded, you get the option to load a mark set, or to create a new set.

From the Fly-out menu of the Dynamic Marks palette, you can

- Load a Mark Set
- Save the current Mark Set
- Manage Mark Sets

5.1 Load Mark Set

To load a Mark Set:

1. In the Fly-out menu of the Dynamic Marks palette, select **Load Mark Set**

The Load dialog will show the Esko Default Mark Sets, and Mark Sets saved at the location defined in the Dynamic Mark Preferences. See *Esko Mark Sets* and *Dynamic Marks Preferences*

**Note:** Since Mark Sets are regular .ai documents, the list will show all Adobe Illustrator files at the defined location. When loading an Illustrator file that doesn't contain a Mark Set, nothing will happen.

2. Select a Mark Set from the list, and click **Load**.

**Note:** If the Mark Set contains a mark with the same name as a mark already in the Dynamic Marks palette, an error message will be given, and the Mark Set will not be loaded.

The marks from the loaded Mark Set are **added** in the Dynamic Marks palette. If you want to replace the current marks with the ones from the loaded Mark Set, you need to select all marks and delete them first.
If you load marks with dependencies, the mark will be attached to the object (e.g. PowerLayout Grid or Named Art) with the same name as in the Mark Set file. If no such object exists, you will get an error message and the mark will be attached to the Trim Box.

5.2 Save Mark Set

To save a Mark Set:

1. In the Fly-out menu of the Dynamic Marks palette, select **Save Mark Set**

The Save dialog will show the Mark Sets already saved at the location defined in the Dynamic Mark Preferences. See **Dynamic Marks Preferences**

2. Enter a name for the Mark Set and click **Save**. If a Mark Set with this name already exists, you will get the option to overwrite it.

**Note:**

You can only save a Mark set if the Illustrator file is saved. If not, you will be prompted to do so before saving the Mark Set

Mark Sets are saved as simple .ai documents, containing only the objects needed for the Mark Set.

**Note:** All Marks in a set need to have a unique name. If not, an error message is shown, and the Mark Set is not saved.

5.3 Manage Mark Sets

To manage your Mark Sets:

1. In the Fly-out menu of the Dynamic Marks palette, select **Manage Mark Sets**
The Manage Dynamic Mark Set dialog will show the Mark Sets saved at the location defined in the Dynamic Mark Preferences. See Dynamic Marks Preferences

**Note:** Since Mark Sets are regular .ai documents, the list will show all Adobe Illustrator files at the defined location.

2. Select a Mark Set from the list, and
   - Click Rename, enter a new name for the Mark Set, and click Rename to change the name of the Mark Set
   - Click Delete to remove the Mark Set from the list. The actual Illustrator file will be deleted. This can not be undone.

5.4 Dynamic Marks Preferences

You can open the Dynamic Marks Preferences by choosing Illustrator > Preferences > Esko > Dynamic Marks Preferences on Mac, or Edit > Preferences > Esko > Dynamic Marks Preferences on Windows.
In the Dynamic Marks Preferences, you can set the location to save and load Mark Sets.

- **Default Folder**: Mark Sets will be saved to and loaded from the default Esko location.
  - on Mac OS X: /Users/Shared/EskoArtwork/DynamicMarks/
  - on Windows Vista and 7: x:\Users\Public\Documents\EskoArtwork\DynamicMarks\
  - on Windows XP: x:\Documents and Settings\All Users\Application Data \EskoArtwork\DynamicMarks\
- **Custom Folder**: Mark Sets will be saved to and loaded from a custom folder which you can select by clicking the **Browse** button.

### 5.5 Esko Mark Sets

When installing Dynamic Marks, a number of default Mark Sets are installed as well. These sets cannot be changed, but you can load one of these sets, change it and save it under a different name.

Here is an overview of these Mark Sets:

**Mark Set 1 (Esko)**

A set for maximum 6 inks in the document, units: mm

- 1 Registration Mark placed on every side
- a Text Mark with the name of the document
- a Text Mark with the date
- a Gradation Strip on the left, with 1 rectangle per ink, colored in 100%
- a Gradation Strip on the right, with a 40%, 80% and 100% rectangle for every ink.
- 6 Text Marks, one per ink, with the name of the ink, and colored in 100% of the ink.

**Mark Set 2 (Esko)**

A set for maximum 6 inks in the document, units: mm

same as Mark Set 1, but with different type of Registration Mark
Mark Set 3 (Esko)
A set for maximum 4 inks in the document, units: mm
- 12 Gallus elements on left and right side of the document

Mark Set 4 (Esko)
A set for maximum 6 inks in the document, units: mm
- Bearer Bars in vertical orientation and attached to the Trim Box
- 6 Text Marks, one per ink, with the name of the ink, placed inside the Bearer Bar, and colored with 0,2% tint to knock out the Bearer Bar in the same separation

Mark Set 5 (Esko)
A set for maximum 12 inks in the document, units: mm
- Bearer Bars in vertical orientation and attached to the Trim Box
- a Gradation Strip on the left, with one circle per ink, colored in 100%.
- a Gradation Strip on the right, with one circle per ink, colored in 50%.
- Registration Marks placed on the left and right side.
- 12 Gallus elements on left and right side of the document
- a Text Mark with the name of the document, colored in registration
- a Custom Mark setting a background for the above mentioned Text Mark
- 12 Text Marks, one per ink, with the name of the ink, and colored in 100% of the ink.
- a Custom Mark setting a background for the above mentioned Text Marks
- 12 Text Marks, one per ink, with the current Angle of the ink, and colored in 100% of the ink.
- 12 Text Marks, one per ink, with the current Ruling of the ink, and colored in 100% of the ink.
- a Text Mark with the date and time
- a Text Mark with the name of the author, based on the XMP info
6. Tips and tricks

I open a new document, create an object to be used as a mark, and as soon as I use "Add Selected Art as Mark", the color of the object changes or disappears. Why?

If you have a document with e.g. only one rectangle, colored with 100% cyan in your document, the Ink Manager will only contain one ink (Cyan).

When you create a custom mark, the default color attribute is "Dynamic". At this moment, the color definition of the mark becomes "100% of the first ink in the ink manager". Because Ink Manager doesn't read inks from marks with color attribute "Registration", "Darkest" or "Dynamic", and because there are no other objects in the document, the inks list in the Ink Manager will be empty, and so will the custom mark be.

As soon as another ink is used in the document, this ink will be the first ink in Ink Manager, and will be used by the Custom Mark.

In the same way, if the original document would contain e.g. one object in cyan and one in magenta (and nothing else), creating a Custom Mark from the cyan object would make magenta the first ink in the ink manager, so the mark would change from cyan to magenta.

Can I start from an existing standard mark to create my own mark symbols?

Yes, you can, as long as you remember to expand the mark / symbol first (i.e. making it a regular object instead of a symbol).

What if I delete a symbol in the DynamicMarks.ai file?

If you delete a symbol in the DynamicMarks.ai file, the symbol will obviously no longer be available in the Set Symbol list. If you delete the default symbol for a Standard Mark, creating the corresponding Standard Mark will result in an error message. To fix this, you have to create these symbols again manually.

Existing marks will NOT be affected, since the symbol is internally copied in the file when creating the mark, or when setting a different symbol. This also means that you can open a file with marks using custom symbols (saved in your local DynamicMarks.ai file) on another computer without losing the marks.

The Dynamic Marks Layer

Standard Marks are created in the Dynamic Marks layer, Custom Marks are moved to the Dynamic Marks layer. However, if the Dynamic Marks layer is locked, you will not be able to add any mark. A message will be shown in the message palette. However, all indirect operations are possible, for example changes in the Ink Manager will change the gradation strip, even if the Dynamic Marks Layer is locked.

If the Dynamic Marks layer is invisible, marks will be created / moved in the Dynamic Marks layer, and will immediately turn invisible.